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SUMMARY:  24 

Here, we present a robust protocol to quantify 40 compounds involved in central carbon and 25 

energy metabolism in cell-free protein synthesis reactions. The cell-free synthesis mixture is 26 

derivatized with aniline for effective separation using reversed-phase liquid chromatography and 27 

then quantified by mass spectrometry using isotopically labelled internal standards.  28 

 29 

ABSTRACT: 30 

Cell-free protein synthesis (CFPS) is an emerging technology in systems and synthetic biology for 31 

the in vitro production of proteins. However, if CFPS is going to move beyond the laboratory and 32 

become a widespread and standard just in time manufacturing technology, we must understand 33 

the performance limits of these systems. Toward this question, we developed a robust protocol 34 

to quantify 40 compounds involved in glycolysis, the pentose phosphate pathway, the 35 

tricarboxylic acid cycle, energy metabolism and cofactor regeneration in CFPS reactions. The 36 

method uses internal standards tagged with 13C-aniline, while compounds in the sample are 37 

derivatized with 12C-aniline. The internal standards and sample were mixed and analyzed by 38 

reversed-phase liquid chromatography-mass spectrometry (LC/MS). The co-elution of 39 

compounds eliminated ion suppression, allowing the accurate quantification of metabolite 40 

concentrations over 2-3 orders of magnitude where the average correlation coefficient was 41 

0.988. Five of the forty compounds were untagged with aniline, however, they were still detected 42 

in the CFPS sample and quantified with a standard curve method. The chromatographic run takes 43 

approximately 10 min to complete. Taken together, we developed a fast, robust method to 44 
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separate and accurately quantify 40 compounds involved in CFPS in a single LC/MS run. The 45 

method is a comprehensive and accurate approach to characterize cell-free metabolism, so that 46 

ultimately, we can understand and improve the yield, productivity and energy efficiency of cell-47 

free systems.  48 

 49 

INTRODUCTION:  50 

Cell-free protein synthesis (CFPS) is a promising platform for manufacturing of proteins and 51 

chemicals, an application that has traditionally been reserved for living cells. Cell-free systems 52 

are derived from crude cell extracts and eliminate the complications associated with cell growth1. 53 

In addition, CFPS allows for direct access to metabolites and the biosynthetic machinery without 54 

the interference of a cell wall. However, a fundamental understanding of the performance limits 55 

of cell-free processes has been lacking. High-throughput methods for metabolite quantification 56 

are valuable for the characterization of metabolism and are critical for the construction of 57 

metabolic computational models2-4. Common methods used to determine metabolite 58 

concentrations include nuclear magnetic resonance (NMR), Fourier transform-infrared 59 

spectroscopy (FT-IR), enzyme-based assays, and mass spectrometry (MS)5-8. However, these 60 

methods are often limited by their inability to efficiently measure multiple compounds at once 61 

and often require a sample size greater than typical cell-free reactions. For example, enzyme-62 

based assays can often only be used to quantify a single compound in a run, and are limited when 63 

the sample size is small, such as in cell-free protein synthesis reactions (typically run on a 10-15 64 

L scale). Meanwhile, NMR requires a high abundance of metabolites for detection and 65 

quantification5.  Toward these shortcomings, chromatography methods in tandem with mass 66 

spectrometry (LC/MS) provide several advantages, including high sensitivity and the capability of 67 

measuring multiple species simultaneously9; however, the analytical complexity increases 68 

considerably with the number and diversity of species being measured. It is important, therefore, 69 

to develop methods that fully realize the high-throughput potential of LC/MS systems. 70 

Compounds in a sample are separated by liquid chromatography and identified through mass 71 

spectrometry. The signal of the compound depends on its concentration and ionization 72 

efficiency, where the ionization can vary between compounds and may also depend on the 73 

sample matrix.   74 

 75 

Achieving the same ionization efficiency between the sample and standards is a challenge when 76 

using LC/MS to quantify analytes. Further, quantification becomes more challenging with 77 

metabolite diversity due to signal splitting and heterogeneity in proton affinity and polarity10. 78 

Lastly, the co-eluting matrix of the sample can also affect the ionization efficiencies of the 79 

compounds. To address these issues, metabolites can be chemically derivatized, increasing the 80 

separation resolution and sensitivity by LC/MS systems, while simultaneously decreasing signal 81 

splitting in some cases10,11. Chemical derivatization works by tagging specific functional groups of 82 

metabolites to adjust their physical properties like charge or hydrophobicity to increase 83 

ionization efficiency11. Various tagging agents can be used to target different functional groups 84 

(e.g., amines, hydroxyls, phosphates, carboxylic acids, etc.). Aniline, one such derivatization 85 

agent, targets multiple functional groups at once, and adds a hydrophobic component into 86 

hydrophilic molecules, thereby increasing their separation resolution and signal12. To address the 87 

co-eluting matrix ion suppression effect, Yang and coworkers developed a technique based on 88 



   

 

 

 

Group Specific Internal Standard Technology (GSIST) labeling where standards are tagged with 89 
13C aniline isotopes and mixed with the sample12,13. The metabolite and corresponding internal 90 

standard have the same ionization efficiency since they co-elute, and their intensity ratio can be 91 

used to quantify the concentration in the experimental sample.  92 

 93 

In this study, we developed a protocol to detect and quantify 40 compounds involved in 94 

glycolysis, the pentose phosphate pathway, the tricarboxylic acid cycle, energy metabolism and 95 

cofactor regeneration in CFPS reactions. The method is based on the GSIST approach, where we 96 

used 12C-aniline and 13C-aniline to tag, detect, and quantify metabolites using reversed-phase 97 

LC/MS. The linear range of all compounds spanned 2-3 orders of magnitude with an average 98 

correlation coefficient of 0.988. Thus, the method is a robust and accurate approach to 99 

interrogate cell-free metabolism, and possibly whole-cell extracts.   100 

.  101 

PROTOCOL:  102 

 103 

1. Preparation of reagents for aniline tagging 104 

 105 

1.1. Prepare a 6 M aniline solution at pH 4.5. Working in a hood, combine 550 µL of aniline with 106 

337.5 µL of LCMS grade water and 112.5 µL of 12 M hydrochloric acid (HCl) in a centrifuge tube. 107 

Vortex well and store at 4 °C. 108 

 109 

NOTE: Aniline can be stored at 4 °C for 2 months. 110 

 111 

CAUTION: Aniline is highly toxic and should be worked with in a fume hood. Hydrochloric acid is 112 

highly corrosive 113 

 114 

1.2. Prepare a 6 M 13C aniline solution at pH 4.5. Combine 250 mg of 13C6-aniline with 132 µL of 115 

water and 44 µL of 12 M HCl. Vortex well and store at 4 °C. 116 

 117 

1.3. Prepare 200 mg/mL N-(3-dimethylaminopropyl)-N-ethylcarbodiimide hydrochloride (EDC) 118 

solution. Dissolve 2 mg of EDC in 10 µL of water for every sample to be tagged and vortex well. 119 

 120 

NOTE: EDC solution should be prepared the same day as the reaction. EDC acts as a catalyst for 121 

the derivatization of compounds with aniline12.  122 

 123 

2. Preparation of standards 124 

 125 

2.1. Make separate stock solutions of all compounds dissolved in LC/MS grade water (Table 1).  126 

 127 

2.2. Preparation of internal standard stock solution 128 

 129 

2.2.1. Combine all compounds except for nicotinamide adenine dinucleotide (NAD), 130 

nicotinamide adenine dinucleotide phosphate (NADP), Flavin adenine dinucleotide (FAD), acetyl 131 



   

 

 

 

coenzyme A (ACA), and glycerol 3-phosphate (Gly3P), with the appropriate volumes to create a 132 

2 mM stock solution of all compounds. 133 

 134 

2.3. Combine NAD, NADP, FAD, ACA, and Gly3P with the appropriate volumes to create a 2 mM 135 

stock solution. 136 

 137 

3. Preparation of sample (Figure 1) 138 

 139 

3.1. Quench and precipitate the proteins in a cell-free protein synthesis reaction by adding an 140 

equal volume of ice-cold 100% ethanol to the reaction. Centrifuge the sample at 12,000 x g for 141 

15 min at 4 °C. Transfer the supernatant to a new centrifuge tube. 142 

 143 

NOTE: Samples can be stored at -80 °C at this point and analyzed at a later time 144 

 145 

4. Labeling reaction  146 

 147 

4.1. Labeling sample with 12C-aniline solution 148 

 149 

4.1.1. Transfer 6 µL of sample into a new centrifuge tube and bring the volume to 50 µL with 150 

water. 151 

 152 

NOTE: Volume sample size may depend on the specific CFPS reaction. 153 

  154 

4.1.2. Add 5 µL of 200 mg/mL EDC solution. 155 

 156 

4.1.3. Add 5 µL of 12C-aniline solution. 157 

 158 

NOTE: The aniline solution separates into two phases. Mix well before adding to the reaction.  159 

 160 

4.1.4. Vortex the reaction with gentle shaking for 2 h at room temperature. 161 

 162 

4.1.5. After 2 h, remove the tubes from the shaker and add 1.5 µL of trimethylamine (TEA) to the 163 

reaction in a fume hood.  164 

 165 

NOTE: Triethylamine raises the pH of the solution which stops the aniline tagging reaction and 166 

stabilizes the compounds. 167 

 168 

CAUTION: Triethylamine is toxic and causes irritation of the eyes and respiratory tract. 169 

 170 

4.1.6. Centrifuge at 13,500 x g for 3 min.  171 

 172 

4.2. Labeling internal standards with 13C-aniline solution 173 

 174 

4.2.1. Dilute internal stock solution to 80 µM with a final volume of 50 µL. 175 



   

 

 

 

 176 

NOTE: Concentration of internal standards can be adjusted to levels close to the experimental 177 

sample.   178 

 179 

4.2.2. Add 5 µL of 200 mg/mL EDC solution. 180 

 181 

4.2.3. Add 5 µL of 13C-aniline solution. 182 

 183 

4.2.4. Vortex the reaction with gentle shaking for 2 h at room temperature. 184 

 185 

4.2.5. After 2 h, remove the tubes from the shaker and add 1.5 µL of TEA to the reaction in a 186 

fume hood.  187 

 188 

4.2.6. Centrifuge at 13,500 x g for 3 min.  189 

 190 

4.3. Combining tagged internal standard and tagged sample 191 

 192 

4.3.1. Mix 25 µL of 12C-aniline labeled sample with 25 µL of 13C-aniline labeled standard. 193 

 194 

4.3.2. Transfer to an auto-sampler vial and analyze by the LC/MS procedure. 195 

 196 

4.4.  Creating a standard curve for untagged metabolites 197 

 198 

4.4.1. Dilute stock solution of untagged metabolites (NAD, NADP, FAD, ACA, and Gly3P) to final 199 

concentrations of 320 µM, 80 µM, 20 µM and 5 µM with a volume of 50 µL. 200 

 201 

4.4.2. Add 5 µL of 200 mg/mL EDC solution. 202 

 203 

4.4.3. Add 5 µL of 12C-aniline solution. 204 

 205 

4.4.4. Vortex the reaction with gentle shaking for 2 h at room temperature. 206 

 207 

4.4.5. After 2 h, remove the tubes from the shaker and add 1.5 µL of TEA to the reaction in a 208 

fume hood.  209 

 210 

4.4.6. Centrifuge at 13,500 x g for 3 min.  211 

 212 

4.4.7. Transfer supernatant to an auto-sampler vial and analyze by the LC/MS procedure. 213 

 214 

NOTE: The untagged metabolites follow the same procedure as the sample to replicate the 215 

sample matrix in order to maintain similar ionization efficiency.  216 

 217 

5. Setup of LC/MS procedure 218 

 219 



   

 

 

 

5.1. Preparation of solvents 220 

 221 

5.1.1. Prepare 5 mM tri-butylamine (TBA) aqueous solution adjusted to pH 4.75 with acetic acid. 222 

 223 

NOTE: TBA in the mobile phase helps the analytes achieve good resolution and separation14.  224 

 225 

5.1.2. Prepare 5 mM TBA in acetonitrile (ACN). 226 

 227 

5.1.3. Prepare wash solvent with 5% water and 95% ACN. 228 

 229 

5.1.4. Prepare purge solvent with 95% water and 5% ACN. 230 

 231 

5.2. Setup of MS conditions 232 

 233 

5.2.1. Set the mass spectrometer to negative ion mode with a probe temperature of 520 °C, 234 

negative capillary voltage of -0.8 kV, positive capillary voltage of 0.8 kV, and set the software to 235 

acquire data at 5 points/s. 236 

 237 

5.2.2. Set selected ion recordings (SIR) for each metabolite with specified cone voltages and mass 238 

over charge (m/z) values. See Table 1. 239 

 240 

5.3. Initializing LC/MS according to manufacturer’s instructions 241 

 242 

5.3.1. Prime solvent lines in the solvent manager for 3 min. 243 

 244 

5.3.2. Prime wash solvent (5% water, 95% ACN) and purge solvent (95% water, 5% ACN) for 15 s 245 

for 5 cycles. 246 

 247 

5.3.3. Set the sample manager to 10 °C. 248 

  249 

5.3.4. Install a C18 (1.7um, 2.1mm x 150mm) column and initialize column with 100% ACN at 0.3 250 

mL/min for 10 min. 251 

 252 

5.3.5. Condition the column at 95% water and 5% ACN at 0.3 mL/min for 10 min prior to 253 

introducing solvents with buffers. 254 

 255 

5.3.6. Condition the column at 95% solvent A (5mM TBA aqueous, pH 4.75) and 5% solvent B (5 256 

mM TBA in ACN) at 0.3 mL/min for 10 min. 257 

 258 

5.3.7. Set up a gradient protocol with the elution starting at 95% solvent A and 5% solvent B, 259 

raised to 70% solvent B in 10 min, raised to 100% solvent B in 2 min and held at 100% solvent B 260 

for 3 min. Return to initial conditions (95% solvent A, 5% solvent B) over 1 min and hold for 9 min 261 

to re-equilibrate the column. 262 

 263 



   

 

 

 

5.3.8. Condition the column with the gradient protocol 3 times prior to any injections onto the 264 

column. 265 

 266 

5.4. Injecting sample and standards 267 

 268 

5.4.1. Inject 5 µL of the sample into the column and acquire the appropriate m/z ion intensities 269 

for the 12C-aniline tagged sample. 270 

 271 

5.4.2. Inject 5 µL of the same sample again, but this time acquire the m/z ion intensities for the 272 
13C-aniline tagged standards. 273 

 274 

NOTE: Our LC/MS system is unable to acquire both 12C and 13C m/z intensities at the specified SIR 275 

time windows, since it is too much data to acquire in the specified time window. Therefore, we 276 

inject the same sample twice.  277 

 278 

5.4.3. Inject untagged metabolite standards from lowest concentration to highest and record the 279 

appropriate m/z ion intensities. 280 

 281 

6. Quantification 282 

 283 

6.1. Creating Export method  284 

 285 

6.1.1. In data acquisition software, select File > New Method > Export Method. 286 

 287 

6.1.2. Specify a Filename, such as AnilineTagging_Date. 288 

 289 

6.1.3. Check the Export ASCII File and choose a directory to export the text file to.  290 

 291 

6.1.4. In Report Type, select Summary by All. 292 

 293 

6.1.5. In Delimiters, for Column select a ,. For Row, select [cr][if]. 294 

 295 

6.1.6. In Table, select Export and then Edit Table to include SampleName, Area, Height, Amount 296 

and Units. 297 

 298 

6.1.7. Save export method. 299 

 300 

6.2. Quantifying metabolites with internal standards using data acquisition software 301 

 302 

6.2.1. Under the Sample Sets tab, right click the corresponding LC/MS run and select View as > 303 

Channels. 304 

 305 

6.2.2. Select all SIR channels for the 13C-aniline internal standards of one injection, right click and 306 

select Review.   307 



   

 

 

 

 308 

6.2.3. If the LC Processing Method Layout window does not automatically appear, go to View > 309 

Processing Method Layout. 310 

 311 

6.2.4. In Processing Method Layout, go to the Integration tab and set ApexTrack as the 312 

algorithm. 313 

 314 

6.2.5. Go to the Smoothing tab and set the type to Mean and the smoothing level to 13. 315 

 316 

NOTE: Any smoothing level can be selected, as long as it is consistent across all samples. 317 

 318 

6.2.6. In the MS Channel tab, disable MS 3D Processing. 319 

 320 

6.2.7. In the SIR channel window, integrate each peak, one channel at a time. Once a peak is 321 

integrated, go to Options > Fill from Result and the details of the peak will be filled in the 322 

Components tab. Change the peak name to the corresponding compound name.  323 

 324 

6.2.8. Once all the SIR channels have been evaluated, save the processing method and close 325 

window. 326 

 327 

6.2.9. Select all SIR channels of the 13C-aniline and 12C-aniline tagged sample, right click and select 328 

Process. 329 

 330 

6.2.10. Check the Process box, select Use specified processing method, and choose the 331 

processing method that is just saved. Also check the Export box, select Use specified export 332 

method and choose the saved export method created earlier. Click OK. 333 

 334 

6.2.11. Open the exported text file with Excel and calculate the concentration of the unknown 335 

compound using: 336 

𝐶𝑥,𝑖 =
𝐴𝑥,𝑖

𝐴𝑠𝑡𝑑,𝑖
𝐶𝑠𝑡𝑑,𝑖𝐷 337 

 338 

where Cx,i is the concentration of the unknown sample for metabolite i, Ax,i is the integrated area 339 

of the unknown metabolite i, Astd,i is the integrated area of the internal standard of metabolite i, 340 

Cstd,i is the concentration of the internal standard of metabolite i, and D is the dilution factor.  341 

 342 

6.3. Quantifying untagged metabolites with standard curve 343 

 344 

6.3.1. Under the Sample Sets tab, right click the corresponding LC/MS run and select View as > 345 

Channels. 346 

 347 

6.3.2. Select all SIR channels for the untagged standards of one injection, right click and select 348 

Review.   349 

 350 



   

 

 

 

6.3.3. If the LC Processing Method Layout window does not automatically appear, go to View > 351 

Processing Method Layout. 352 

 353 

6.3.4. In Processing Method Layout, go to the Integration tab and set ApexTrack as the 354 

algorithm. 355 

 356 

6.3.5. Go to the Smoothing tab and set the type to Mean and the smoothing level to 13. 357 

 358 

NOTE: Any smoothing level can be selected, as long as it is consistent across all samples. 359 

 360 

6.3.6. In the MS Channel tab, disable MS 3D Processing. 361 

 362 

6.3.7. In the SIR channel window, integrate each peak, one channel at a time. Once a peak is 363 

integrated, go to Options > Fill from Result and the details of the peak will be filled in the 364 

Components tab. Change the peak name to the corresponding compound name.  365 

 366 

6.3.8. Once all the SIR channels have been evaluated, save the processing method and close 367 

window. 368 

 369 

6.3.9. Under the Sample Sets tab, right click on the sample set and select Alter Sample. 370 

 371 

6.3.10. Select Amount in the new window. 372 

 373 

6.3.11. Select copy from Process method and choose the process method that was just saved.  374 

 375 

6.3.12. Enter the concentration of each metabolite for each vial and enter the unit as <μM for 376 

each component (or the corresponding unit) and select OK. 377 

 378 

6.3.13. Select the sample set again, right click, View as > Channels. 379 

 380 

6.3.14. Select all SIR channels of the untagged metabolites for the standards, right click and select 381 

Process. 382 

 383 

6.3.15. Check the Process box and choose Use specified processing method. Select the 384 

appropriate processing method and click OK. 385 

 386 

6.3.16. Select SIR channels for all untagged metabolites for the samples, right click and select 387 

Process. 388 

 389 

6.3.17. Check the Process box, select Use specified processing method, and choose the 390 

processing method that was just saved. Also check the Export box, select Use specified export 391 

method and choose the saved export method created earlier. Click OK. 392 

 393 



   

 

 

 

6.3.18. Quantify the untagged metabolites with the standard curve and export the results to a 394 

text file to the directory specified. 395 

 396 

REPRESENTATIVE RESULTS:  397 

As a proof-of-concept, we used the protocol to quantify metabolites in an E. coli based CFPS 398 

system expressing green fluorescent protein (GFP).  The CFPS reaction (14 L) was quenched and 399 

deproteinized with ethanol. The CFPS sample was then tagged with 12C-aniline, while standards 400 

were tagged with 13C-aniline. The tagged sample and standards were then combined and injected 401 

into the LC/MS (Figure 1). The protocol detected and quantified 40 metabolites involved in 402 

central carbon and energy metabolism using internal standards, while a standard curve for 5 of 403 

the metabolites that were not tagged with aniline was also developed (Figure 2). The diverse 404 

metabolites involved in these pathways were a class of phosphorylated sugars, 405 

phosphocarboxylic acids, carboxylic acids, nucleotides, and cofactors. The derivatization with 406 

aniline introduced a hydrophobic moiety into hydrophilic molecules which facilitated more 407 

effective separation using reversed-phase chromatography12. In addition, the method enabled 408 

the separation of structural isomer pairs such as glucose 6-phosphate and fructose 6-phosphate 409 

in a single LC/MS run. Each compound’s mass over charge (m/z) ratio and retention time were 410 

identified prior to the experiment by injecting 1 mM of one compound at a time and comparing 411 

the mass spectrum to the blank (Table 1).   412 

 413 

The limit of detection and range of linearity for all compounds was estimated by producing a 414 

standard curve that ranged from 0.10 µM to 400 µM (Table 2). The average correlation 415 

coefficient (R2) for all compounds was 0.988 and most compounds had a linear range of 3-orders 416 

of magnitude. Three compounds had notable saturation effects, especially alpha-ketoglutarate 417 

which had a linear range from 0.1 µM to 25 µM. Isocitrate and citrate also had saturation effects 418 

above 100 µM. 419 

 420 

FIGURE AND TABLE LEGENDS:  421 

Figure 1: Schematic of workflow for aniline tagging. The cell-free protein synthesis reaction is 422 

deproteinized and tagged with 12C-aniline, while a standard stock mixture is tagged with 13C-423 

aniline. Both mixtures are then mixed at a 1:1 volumetric ratio and analyzed by LC/MS. 424 

 425 

Figure 2: Overlapped selected ion chromatograms for 40 metabolites. Mass chromatogram 426 

from a single LC/MS run of a 40 µM standard mixture of 40 metabolites. Peaks were identified 427 

by their retention time and m/z values for each compound. Complete compound names and their 428 

abbreviations are listed in Table 1. 429 

 430 

Table 1: Identification and labeling results of metabolites. Each compound’s corresponding peak 431 

number, retention time, m/z value for unlabeled, 12C and 13C labeled, and MS species. MS Species, 432 

A stands for Aniline tag. 433 

 434 

Table 2: Metabolite quantification in a representative CFPS sample. The concentration of each 435 

metabolite and the standard deviation. Limit of detection, range of linearity and correlation 436 

coefficient identified from standard curves.  437 



   

 

 

 

  438 

DISCUSSION:  439 

Cell-free systems have no cell wall, thus there is direct access to metabolites and the biosynthetic 440 

machinery without the need for complex sample preparation. However, very little work has been 441 

done to develop thorough and robust protocols to quantitatively interrogate cell-free reaction 442 

systems. In this study, we developed a fast, robust method to quantify metabolites in cell-free 443 

reaction mixtures and potentially in whole-cell extracts. Individual quantification of metabolites 444 

in complex mixtures, such as those found in cell-free reactions, or whole-cell extracts, is 445 

challenging for several reasons. Central amongst these reasons is chemical diversity. The array of 446 

functional groups simultaneously present in these mixtures (e.g., carboxylic acids, amines, 447 

phosphates, hydroxyls, etc.) greatly increases the analytical complexity. To circumvent this, we 448 

used an aniline derivatization method in combination with 13C internal standards to introduce 449 

hydrophobic components to the metabolite mixtures. Using this method, we robustly detected 450 

and quantified 40 metabolites in a cell-free reaction in a single LC/MS run. The protocol tagged 451 

35 of the 40 compounds in this study, while the remaining 5 compounds were quantified with a 452 

standard curve method. Earlier work suggested the reaction conditions formed an intramolecular 453 

salt between the amine and phosphate group that inhibited derivatization12. Reaction conditions 454 

were not identified for simultaneous derivatization of all 40 compounds; however, the current 455 

alternative is quantification with a standard curve method. While we demonstrated this 456 

technique in a cell-free reaction mixture, it could also likely be applied to whole-cell extracts, 457 

thus, potentially allowing the absolute quantification of intracellular metabolites concentrations. 458 

The latter application has relevance to a variety of important questions in biotechnology and 459 

human health.  460 

 461 

The method presented here was based on a previous technique (GSIST) that was applied to 462 

whole-cell extracts of the yeast S. cerevisiae12,13. In this study, we expanded the number of 463 

compounds which could be detected and quantified, including all 12 nucleotides (xMP, xDP, xTP, 464 

where x is A, C, G and U). Addition of these compounds could have important biological 465 

implications. For example, these nucleotides are heavily involved in transcription and translation 466 

processes, which is one of the central processes of interest in CFPS applications, and more 467 

generally the compounds are important in a variety of physiological functions. In addition, we 468 

were able to detect acetic acid which is an important metabolite when examining overflow 469 

metabolism. However, we did not include it in the study because there was a significant reduction 470 

of signal in multiple compounds, especially nicotinamide adenine dinucleotide reduced (NADH) 471 

and nicotinamide adenine dinucleotide phosphate reduced (NADPH) when acetic acid was added 472 

to the standard mixture. Acetic acid had a high limit of detection of 612 µM, thus at these high 473 

levels it had a negative effect on the other metabolites’ signals. Despite this, acetic acid can still 474 

be detected and quantified in samples by creating a standard curve with just acetic acid in the 475 

vial. Acetic acid had a m/z value of 134.0, retention time of 5.78 min, and a linear range from 612 476 

µM to 5000 µM (R2 = 0.986) when tagged with 12C-aniline. The remaining metabolites did not 477 

alter each other’s ion signal and represent a comprehensive mixture to characterize CFPS 478 

metabolism. The protocol presented here is limited to metabolites involved in central carbon and 479 

energy metabolism. Thus, the current method is unable to measure metabolite abundance from 480 

other pathways that may be of importance, such as fatty acid and amino acid metabolism.  481 



   

 

 

 

 482 

Taken together, we developed a fast, robust protocol for the characterization and absolute 483 

quantification of 40 compounds involved in glycolysis, the pentose phosphate pathway, the 484 

tricarboxylic acid cycle, energy metabolism, and cofactor regeneration in CFPS reactions. The 485 

method relied on internal standards tagged with 13C-aniline, while the sample was tagged with 486 
12C-aniline. The internal standards and sample compounds co-eluted and eliminated ion-487 

suppression effects which enabled accurate quantification of individual metabolites in complex 488 

metabolite mixtures. We identified a total of 40 compounds (41, if including acetic acid) that can 489 

be detected and quantified in a cell-free reaction mixture; however, the list of metabolites could 490 

be further expanded and adjusted towards the particular biochemical process of interest. Thus, 491 

the method provides a robust and accurate approach to characterize cell-free metabolism, which 492 

is potentially critical to improving the yield, productivity and energy efficiency of cell-free 493 

processes.   494 

 495 
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Peak Number Metabolite Abbreviation KEGG ID Retention Time (min)12C m/z 13C m/z

1 Glycerol 3-phosphateGly3P C00093 3.85

2 Nicotinamide adenine dinucleotideNAD C00003 3.96

3 Glucose GLC C00031 4.06 289.9 296

4 Sedoheptulose 7-phosphateS7P C05382 5.41 364 370

5 Fructose 6-phosphateF6P C00085 5.48 334 340

6 Guanosine monophosphateGMP C00144 5.57 437.05 443

7 Ribulose 5-phosphateRL5P C00199 5.58 304 310

8 Cytidine monophosphateCMP C00055 5.59 397.09 403

9 Lactate LAC C00186 5.77 164.05 170

10 Adenosine monophosphateAMP C00020 5.85 421.1 427.1

11 Uridine monophosphateUMP C00105 5.88 398.07 404

12 Nicotinamide adenine dinucleotide phosphateNADP C00006 6.39

13 3-Phosphoglyceric acid3PG C00197 6.63 242 248.06

14 Cytidine diphosphateCDP C00112 6.72 477 483

15 Guanosine diphosphateGDP C00035 6.87 517 523

16 Adenosine diphosphateADP C00008 6.94 501 507

17 Uridine diphosphateUDP C00015 6.97 478 484

18 Flavin adenine dinucleotideFAD C00016 7.03

19 Fructose 1,6-bisphosphateF16P C05378 7.1 395.95 402.1

20 Gluconate 6-phosphate6PG C00345 7.11 425.1 437

21 Nicotinamide adenine dinucleotide reducedNADH C00004 7.23 633.13 639.08

22 Glucose 6-phosphateG6P C00668 7.32 409.1 421.1

23 Ribose 5-phosphateR5P C00117 7.54 379.1 391.1

24 Erythrose 4-phosphateE4P C00279 7.71 348.9 361

25 Cytidine triphosphateCTP C00075 7.84 557 563

26 Guanosine triphosphateGTP C00044 7.93 597 603

27 Oxalacetate OAA C00036 7.94 281 293

28 Alpha-ketoglutarateaKG C00026 7.95 295 307.1

29 Uridine triphosphate UTP C00075 7.97 558 564

30 Adenosine triphosphateATP C00002 8.03 581 587

31 Fumarate FUM C00122 8.09 265 277.1

32 Pyruvate PYR C00022 8.09 162 168

33 Malate MAL C00149 8.09 283.06 295.15

34 D-glyceraldehyde 3-phosphateGAP C00118 8.09 319 331.1

35 Acetyl-coenzyme AACA C00024 8.16

36 Nicotinamide adenine dinucleotide phosphate reducedNADPH C00005 8.23 694.92 700.82

37 PhosphoenolpyruvatePEP C00074 8.28 317 329.1

38 Succinate SUCC C00042 8.64 267.07 279.1

39 Isocitrate ICIT C00311 10.13 398 416

40 Citrate CIT C00158 10.46 416.1 434.06
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nonlabel m/z CV MS Species

153 10 M – H2O – H

698 10 M + Cl – H

15 M + A + Cl - H

10 M + A – H

10 M + A – H

10 M + A – H

10 M + A – H

10 M + A – H

10 M + A – H

10 M + A – H

10 M + A – H

724 10 M - H2O – H

15 M + A – H2O – H

10 M + A – H

10 M + A – H

10 M + A – H

10 M + A – H

784.15 15 M – H 

10 M + A – H2O – H

10 M + 2A – H

10 M + A + H2O – nicotinamide – H

10 M + 2A – H

15 M + 2A – H

10 M + 2A – H

5 M + A – H

5 M + A – H

25 M + 2A – H

15 M + 2A – H

10 M + A – H

15 M + A – H

10 M + 2A – H

25 M + A – H

10 M + 2A – H

5 M + 2A – H

790 10 M – H2O – H

10 M + A – nicotinamide – H

20 M + 2A – H

15 M + 2A – H

10 M + 3A – H2O – H

20 M + 3A – H



Peak No. Metabolite Abbreviation KEGG ID Concentration (mM)SD (n = 3)

1 Glycerol 3-phosphateGly3P C00093 0.377 0.034

2 Nicotinamide adenine dinucleotideNAD C00003 0.052 0.010

3 Glucose GLC C00031 0.002 0.000

4 Sedoheptulose 7-phosphateS7P C05382 0.007 0.000

5 Fructose 6-phosphateF6P C00085 0.029 0.004

6 Guanosine monophosphateGMP C00144 0.007 0.001

7 Ribulose 5-phosphateRL5P C00199 0.035 0.002

8 Cytidine monophosphateCMP C00055 0.045 0.001

9 Lactate LAC C00186 2.134 0.048

10 Adenosine monophosphateAMP C00020 0.020 0.002

11 Uridine monophosphateUMP C00105 0.021 0.000

12 Nicotinamide adenine dinucleotide phosphateNADP C00006 0.014 0.002

13 3-Phosphoglyceric acid3PG C00197 6.125 0.239

14 Cytidine diphosphateCDP C00112 0.202 0.029

15 Guanosine diphosphateGDP C00035 0.146 0.027

16 Adenosine diphosphateADP C00008 0.797 0.161

17 Uridine diphosphateUDP C00015 0.212 0.036

18 Flavin adenine dinucleotideFAD C00016 0.008 0.001

19 Fructose 1,6-bisphosphateF16P C05378 3.643 0.105

20 Gluconate 6-phosphate6PG C00345 0.017 0.001

21 Nicotinamide adenine dinucleotide reducedNADH C00004 0.063 0.028

22 Glucose 6-phosphateG6P C00668 0.046 0.002

23 Ribose 5-phosphateR5P C00117 0.055 0.005

24 Erythrose 4-phosphateE4P C00279 0.038 0.007

25 Cytidine triphosphateCTP C00075 0.896 0.078

26 Guanosine triphosphateGTP C00044 0.870 0.109

27 Oxalacetate OAA C00036 0.023 0.008

28 Alpha-ketoglutarateaKG C00026 0.391 0.020

29 Uridine triphosphate UTP C00075 0.845 0.092

30 Adenosine triphosphateATP C00002 1.557 0.188

31 Fumarate FUM C00122 0.576 0.100

32 Pyruvate PYR C00022 5.813 0.804

33 Malate MAL C00149 2.548 0.269

34 D-glyceraldehyde 3-phosphateGAP C00118 2.194 0.367

35 Acetyl-coenzyme AACA C00024 0.196 0.044

36 Nicotinamide adenine dinucleotide phosphate reducedNADPH C00005 0.006 0.010

37 PhosphoenolpyruvatePEP C00074 3.442 0.345

38 Succinate SUCC C00042 5.683 0.573

39 Isocitrate ICIT C00311 0.003 0.006

40 Citrate CIT C00158 0.002 0.001
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Limit of Detection (μM) Limit of Linear Range (μM)R^2

0.1 400 0.995

0.39 400 0.993

0.1 400 0.997

0.16 400 0.988

0.1 400 0.986

0.39 100 0.992

0.39 400 0.996

0.1 100 0.992

0.1 400 0.988

0.1 100 0.992

0.1 100 0.997

0.34 400 0.950

0.1 100 0.996

0.39 400 0.997

1.5625 400 0.984

0.39 400 0.995

0.39 400 0.991

0.1 400 0.958

0.39 400 0.989

0.39 400 0.989

0.39 100 0.972

0.1 400 0.984

0.39 100 0.999

0.39 400 0.979

6.25 100 0.998

6.25 100 0.993

0.56 400 0.997

0.1 25 0.979

1.5625 400 0.998

1.5625 400 0.991

1.5625 100 0.999

0.39 400 0.993

0.1 400 0.991

0.1 100 0.974

0.1 100 0.991

0.14 100 0.990

0.1 100 0.962

0.1 320 0.999

0.39 100 0.998

0.1 100 0.981



Name of Material/Equipment Company Catalog Number Comments/Description
12C Aniline Sigma-Aldrich 242284 Aniline 12C

13C labeled aniline Sigma-Aldrich 485797 Aniline 13C6

3-Phosphoglyceric acid Sigma-Aldrich P8877 3PG

Acetic Acid FisherScientific AC222140010 ACE

Acetonitrile, LCMS JT BAKER 9829-03 ACN

Acetyl-coenzyme A Sigma-Aldrich A2056 ACA

Acquity UPLC BEH C18 1.7 μM, 2.1 x 150 mm ColumnWaters 186002353 Column

Adenosine diphosphate Sigma-Aldrich A2754 ADP

Adenosine monophosphate Sigma-Aldrich A1752 AMP

Adenosine triphosphate Sigma-Aldrich A2383 ATP

Alpha-ketoglutarate Sigma-Aldrich K1128 aKG

Citrate Sigma-Aldrich 251275 CIT

Cytidine diphosphate Sigma-Aldrich C9755 CDP

Cytidine monophosphate Sigma-Aldrich C1006 CMP

Cytidine triphosphate Sigma-Aldrich C9274 CTP

D-glyceraldehyde 3-phosphate Sigma-Aldrich 39705 GAP

Erythrose 4-phosphate Sigma-Aldrich E0377 E4P

Ethanol Sigma-Aldrich EX0276 EtOH

Fisher Scientific accuSpin Micro 17 CentrifugeFisherScientific Centrifuge

Flavin adenine dinucleotide Sigma-Aldrich F6625 FAD

Fructose 1,6-bisphosphate Sigma-Aldrich F6803 F16P

Fructose 6-phosphate Sigma-Aldrich F3627 F6P

Fumarate Sigma-Aldrich F8509 FUM

Gluconate 6-phosphate Sigma-Aldrich P7877 6PG

Glucose Sigma-Aldrich G8270 GLC

Glucose 6-phosphate Sigma-Aldrich G7879 G6P

Glycerol 3-phosphate Sigma-Aldrich G7886 Gly3P

Guanosine diphosphate Sigma-Aldrich G7127 GDP

Guanosine monophosphate Sigma-Aldrich G8377 GMP

Guanosine triphosphate Sigma-Aldrich G8877 GTP

Hydrochloric acid Sigma-Aldrich 258148 HCl 

Isocitrate Sigma-Aldrich I1252 ICIT

Lactate Sigma-Aldrich L1750 LAC
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Malate Sigma-Aldrich 02288 MAL

myTXTL - Sigma 70 Master Mix Kit ArborBiosciences 507024 Cell-free protein synthesis

N-(3-dimethylaminopropyl)-N′-ethylcarbodiimide hydrochlorideSigma-Aldrich 03449 EDC

Nicotinamide adenine dinucleotide Sigma-Aldrich 43410 NAD

Nicotinamide adenine dinucleotide phosphateSigma-Aldrich N5755 NADP

Nicotinamide adenine dinucleotide phosphate reducedSigma-Aldrich 481973 NADPH

Nicotinamide adenine dinucleotide reducedSigma-Aldrich N8129 NADH

Oxalacetate Sigma-Aldrich O4126 OAA

Phosphoenolpyruvate Sigma-Aldrich P0564 PEP

Pyruvate Sigma-Aldrich P5280 PYR

Ribose 5-phosphate Sigma-Aldrich R7750 R5P

Ribulose 5-phosphate CarboSynth MR45852 RL5P

Sedoheptulose 7-phosphate CarboSynth MS07457 S7P

Succinate Sigma-Aldrich S3674 SUCC

Tributylamine Sigma-Aldrich 90780 TBA

Triethylamine FisherScientific O4884 TEA

ultrapure water FisherScientific 10977-015 water

Uridine diphosphate Sigma-Aldrich U4125 UDP

Uridine monophosphate Sigma-Aldrich U6375 UMP

Uridine triphosphate Sigma-Aldrich U6625 UTP

VWR Heavy Duty Vortex VWR Vortex

Water, LCMS JT BAKER 9831-03 WATER

Waters Acquity H UPLC Class Quaternary Solvent ManagerWaters LCMS

Waters Acquity H UPLC Class Sample Manager FTNWaters LCMS

Waters Acquity Qda detector Waters LCMS

Waters Empower 3 Waters Software

Waters LCMS Total Recovery Vial Waters 186000384c LCMS Vial
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